Задание № 1.6. Перемещение (панорамирование) увеличенного изображения
[bookmark: _GoBack]При создании иллюстраций с мелкими деталями приходится значительно масштабировать (увеличивать) изображение, в результате некоторые элементы оказываются за рамками экрана. В этом случае приходится перемещать изображение относительно экрана, а точнее, перемещать экран относительно изображения. Рабочую страницу перемещают также для того, чтобы удобнее разместить ее на экране, при наличии большого числа панелей и элементов вне рабочей страницы. Для панорамирования удобнее всего использовать инструмент Pan \ Hand (Панорама \ Рука).
1.	Используйте предыдущий документ или откройте любой документ
CorelDRAW.
2. На панели Tools (Инструменты) выберите инструмент Pan \ Hand (Панорама \ Рука). Он входит в группу инструментов Zoom (Масштаб).
3. Для перемещения рабочей страницы зафиксируйте указатель инструмента Pan \ Hand (Панорама \ Рука) в произвольном свободном месте рабочей области и перетащите страницу со всем ее содержимым в требуемое место.
Задание № 1.7. Создание нескольких групп объектов
1.	Создайте новый документ с типичными настройками.
2.	Создайте инструментами Rectangle (Прямоугольник), Ellipse (Эллипс),
Polygon (Многоугольник), Star (Звезда) четыре разноцветных флагов разме
ром 60х40 мм по образцам. Для корректировки некоторых параметров выде
ленных объектов следует использовать панель атрибутов Property Bar
(Свойства). Задавать точные габаритные размеры удобно в цифровых полях
ширина и высота. Следуйте указаниям:
•   Треугольники создаются инструментом Polygon (Многоугольник).

· Цвета заливок Fill выделенных объектов выбираются одним щелчком левой клавиши мыши (1ЩЛевКМ) по соответствующему цвету палитры цветов.
· Цвета контуров Outline (или отсутствие контуров) объектов определяются одним щелчком правой клавиши мыши (1ЩПрКМ) по соответствующему цвету (или по значку Х) палитры цветов.
· Используйте команды Arrange ► Order ► To Front (Упорядочить ► Порядок \ Монтаж ► На передний план) и Arrange ► Order ► To Back (Упорядочить ► Порядок \ Монтаж ► На задний план) для правильного расположения объектов флагов.
· Объекты каждого созданного флага сгруппируйте командой Group.
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Задание № 1.8. Трансформация объектов
Нарисуйте домик согласно приведенной последовательности, используя маркеры размеров, поворота, скоса.
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Задание № 1.9. Взаимодействие нескольких объектов
При выделении нескольких объектов на панели атрибутов Property Bar доступны кнопки, дублирующие некоторые полезные команды меню Arrange (Упорядочить \ Монтаж). Рекомендуется пользоваться именно кнопками.
Команда Arrange ► Combine (Упорядочить ► Объединить) — соединяет несколько объектов в один единый, состоящий из нескольких подконтуров, с новыми свойствами.
Команда Arrange ► Break Apart (Упорядочить ► Разъединить), обратная предыдущей — разъединяет подконтуры одного объекта и составные объекты на отдельные объекты.
Команда Arrange ► Shaping ► Weld (Упорядочить ► Формирование ► Объединение) — объединяет контуры нескольких объектов по периметру.
Команда Arrange ► Shaping ► Trim (Упорядочить ► Формирование ► Исключение) — отсекает от последнего выделенного объекта часть равную другим объектам.
Команда Arrange ► Shaping ► Intersection (Упорядочить ► Формирование ► Пересечение) — создает новый объект равный пересечению выделенных объектов
Команда   Arrange ► Shaping ► Simplify   (Упорядочить ►    Формирование ► Упрощение) — отсекает перекрытые части во всех выделенных объектах
Чтобы разобраться в действиях перечисленных кнопок выполните следующее.
1. Создайте три частично перекрывающих друг друга объекта. Создайте дубликаты этих троек не менее 6 штук.
2. К первой тройке примените Group (Сгруппировать). Ко второй тройке -Combine (Соединить). К остальным тройкам объектов - команды подменю Shaping (Формирование), используя кнопки на панели атрибутов Property Bar. 3. Проанализируйте свойства полученных объектов, зависимость свойств от порядка выделения объектов.
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Задание № 1.10. Инструменты группы Shapes \ Perfect Shape
Группа инструментов Shapes (Фигуры \ Автофигуры \ Правильная форма), включает инструменты создания специфических объектов простым рисованием выбранной формы. После выбора соответствующего инструмента создаваемые им фигуры выбираются на панели Property Bar (Свойства).
В процессе создания фигур (автофигур) имеется возможность изменить не только размер фигуры, но и соотношение размеров или вообще формы. Для этого служат одна или две контрольные точки (узлы), автоматически создаваемых при рисовании фигуры. После создания фигуры обычными методами можно выполнить ее заливку и присвоить цвет и ширину контура обводке.
Кроме того, при создании фигур действуют стандартные назначения клавиш Shift (создание фигуры из центра условного прямоугольника) и Ctrl (вписывание фигуры в условный квадрат).
В программе есть следующие инструменты создания фигур:
Basic Shapes (Основные фигуры); Arrow (Стрелки); Flowchart (Блок-схемы); Banner (Баннер) или Star (Звезды); Callout (Выноски).
ВАЖНО! Автофигуры, имеющие незамкнутые линии, (т.е. нечетное число линий в одной точке, например, смайлик и цилиндр), НЕ корректно преобразуются в кривую Безье.
1. Создайте новый документ и выполните его настройки.
2. Отделите группу инструментов Shapes (Автофигуры) от панели Tools (Инструменты).
3. Активизируйте первый инструмент группы — Basic Shapes (Основные фигуры).
4. На панели атрибутов Property Bar (Свойства) раскройте список создаваемых инструментом форм.
5. Выберите значок плюса.
6. Зафиксируйте инструмент на рабочей странице и растяните указатель для создания объекта.
7. Сразу после окончания рисования подведите указатель к красному маркеру на форме и измените форму объекта.
8. 
9. Выполните заливку созданного объекта. Измените цвет его контура.
10. Аналогичным образом создайте объекты другими инструментами группы.
Самостоятельная работа по теме 1
1. Создайте новый документ.
2. Параметры документа:

· формат страницы А4, ориентация Portrait (Книжная);
· единицы измерения миллиметры;
· шаг курсорных клавиш 0,1 мм.
3.	Используя инструменты для построения стандартных объектов и команды
меню Arrange (Упорядочить), создайте предложенные изображения. Жела
тельно преобразовать каждую фигуру в один объект.
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[bookmark: bookmark0]Практическая работа по теме 2. Инструменты создания контуров и управления параметрами контура. Изменение формы объектов
Задание № 2.1. Создание объектов инструментами Freehand (Свободная линия \ Рисование) и Bezier (Кривая Безье)
1. Создайте новый документ и выполните его настройки.
2. С помощью инструмента Freehand (Свободная форма \ Рисование) создайте кривую, удерживая левую клавишу мыши. Удалить часть кривой можно, перемещая мышь в обратном направлении и удерживая клавишу <Shift>. Для того, чтобы продолжить рисование созданной ранее кривой, нужно выделить ее, активизировать инструмент Freehand и подвести курсор к конечной или начальной точке. Рядом с указателем появится стрелка. Нажмите левую клавишу мыши и продолжите рисование. Линия автоматически замкнется, если начальная и конечная точки окажутся на близком расстоянии. Тогда рядом с указателем появится маленькая стрелочка.
3. Нарисуйте инструментом Freehand (Свободная линия \ Рисование) отрезок прямой. Для этого один раз щелкните левой клавишей мыши в начале линии и один раз — в конце. Для построения ломаной щелкните в конце первого отрезка дважды, продолжите построение в любом направлении, для завершения построения щелкните один раз.
4. Попробуйте нарисовать кривую с помощью инструмента Bezier (Кривая Безье). Для этого один раз щелкните левой клавишей мыши в начале предполагаемой кривой, затем установите курсор в другом месте (это будет вторая опорная точка), нажмите клавишу мыши и потяните в сторону. От опорной точки потянутся направляющие линии. Длина и угол наклона направляющих определяют кривизну линии между опорными точками. Отпустите клавишу и нажмите в новом месте. Задавая новые опорные точки, можно получить кривую линию любой сложности. С помощью кривых Безье создаются максимально точные контуры с минимальным количеством опорных точек.
5. Создайте инструментом Bezier (Кривая Безье) ломаную линию. Для построения ломаной щелкайте левой клавишей мыши в узловых точках. Каждый новый щелчок продолжает построение ломаной. Закончить построение можно, либо переключившись на другой инструмент (можно нажать пробел), либо замкнув объект, щелкнув в начальной точке.
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Задание № 2.2. Создание изображения сердечка
1. Создайте эллипс и преобразуйте его в кривую командой Arrange ► Convert To Curves (Преобразовать в кривую).
2. Выберите инструмент Shape (Форма). На кривой станут видны четыре маленьких маркера. Это узлы кривой.
3. Инструментом Shape (Форма) выделите и удалите левый и правый узлы. Узлов останется два.
4. На панели атрибутов Property Bar (Свойства) щелкните по кнопке Select All Nodes (Выделить все узлы). Будут выделены оставшиеся два узла.
5. На панели атрибутов Property Bar (Свойства) щелкните по кнопке Cusp mode \ Make Node A Cusp (Перегиб \ Острый угол). Изменится тип узлов, но на форме кривой это пока не отразится.
6. Щелкните в свободном месте экрана, что бы снять выделение.
7. Выделите верхний узел. Станут видны его управляющие рычаги (маркеры управления). Станут видны управляющие рычаги и у соседнего узла (а их всего два), но пользоваться ими не надо.
8. Ухватитесь за кончик правого верхнего управляющего рычага (маркера) и потяните его вверх. Должна измениться форма только правой части кривой.
9. Ухватитесь за кончик левого верхнего управляющего рычага (маркера) и аналогично потяните его вверх. Должна измениться форма уже и левой части кривой.

10. Выделите нижний узел.
11. Ухватитесь за кончик правого нижнего управляющего рычага (маркера) и потяните его вверх.
12. Ухватитесь за кончик левого нижнего управляющего рычага (маркера) и тоже потяните его вверх. Постарайтесь соблюдать симметрию.
13. Сделайте один щелок левой клавишей мыши (1ЩЛевКМ) по красному цвету палитры цветов. Объект получит красную заливку.
14. Редактировать форму кривой можно, ухватившись непосредственно за линию.
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Задание № 2.3. Создание изображения елки
1. Создайте новый документ и выполните его настройки.
2. Создайте эллипс и преобразуйте его в кривую командой Arrange ► Convert To Curves (Преобразовать в кривую).
3. Инструментом Shape (Форма) добавьте на кривую еще 6 узлов и измените форму объекта по образцу лапы елки. Выберите для заливки оттенок зеленого цвета.
4. Инструментом Freehand (Свободная форма \ Рисование) нарисуйте иголки. Выберите толщину иголок и цвет, отличный от предыдущего. Сгруппируйте кривую и иголки. Получится отдельная елочная “лапа”.
5. Создавая дубликаты, поворачивая, масштабируя и скашивая лапу с иголками, составьте елку.
6. Инструментом Polygon (Многоугольник) создайте пятиугольник.
7. НЕ преобразовывая его в кривую, инструментом Shape (Форма) превратите пятиугольник в звезду.
8. Поворачивая и копируя звезду, применяя Shape (Форма) к копиям, нарисуйте многолучевую звезду из нескольких объектов. Разместите её на вершине елки.
9. Для ликвидации просветов создайте на заднем плане произвольный многоугольник

10. Прикройте кругами наиболее слабые места елки.
11. Инструментом Freehand создайте несколько линий толщиной 2 мм или 6 pt (пунктов). Превратите их в линии переменной толщины, применив к ним средства предоставляемые полем Calligraphy (Каллиграфическое \ Каллиграфия) диалогового окна Outline Pen (Перо для контура \ абриса).
12. Выделите и сгруппируйте все объекты составляющие елку. Уменьшите размер елки примерно в пять раз. Несмотря на уменьшение габаритных размеров, толщины контуров останутся неизменными. Это нарушает композицию, пример на рис. 2.4. (1). Отмените уменьшение елки. Выделите группу объектов, составляющих елку. Вызовите окно Outline Pen (Перо для контура \ абриса). Поставьте флажок Scale with image (Сохранять пропорции \ Масштабировать вместе с изображением), другие параметры не меняйте. Нажмите ОК. Опять уменьшите размер елки примерно в пять раз. Теперь толщины контуров изменятся пропорционально изменению размеров объектов. На рис. 2.4. (2).
13. 
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Задание № 2.4. Построение объектов по трем точкам
1. Создайте новый документ и выполните его настройки.
2. Выберите инструмент 3 Point Rectangle (Прямоугольник по 3 точкам).
Инструмент 3 Point Rectangle (Прямоугольник по 3 точкам) скорее рисует прямоугольник не по 3 точкам, а по двум сторонам. Так, для создания прямоугольника инструментом 3 Point Rectangle (Прямоугольник по 3 точкам) необходимо щелкнуть его курсором в начальной точке одной стороны прямоугольника, протянуть указатель до конца этой стороны и отпустить его, после этого повести указатель под прямым углом к созданной стороне прямоугольника и щелкнуть в конечной точке этой стороны.
2. Инструментом 3 Point Rectangle (Прямоугольник по 3 точкам) нарисуйте прямоугольник с угловой точки под произвольным углом. При использовании инструмента 3 Point Rectangle (Прямоугольник по 3 точкам) также действуют клавиши <Ctrl> (создание квадрата) и <Shift> (прямоугольник из центральной точки).
3. Нарисуйте прямоугольник из центральной точки, расположенный вертикально размером 25×75 мм. Выполните его обводку и заливку.
4. Нарисуйте квадрат со скругленными углами 30, 60, 60, 30.
5. Самостоятельно нарисуйте прямоугольники различным образом. Составьте из них композицию.
6. На панели Tools (Инструменты \ Панель графики) активизируйте инструмент 3 Point Ellipse (Эллипс по 3 точкам).
Работа с инструментом 3 Point Ellipse (Эллипс по 3 точкам) с одной стороны ничем не отличается от работы с инструментом Ellipse (Эллипс), с другой стороны — аналогична работе с инструментом 3 Point Rectangle (Прямоугольник по 3 точкам).
Для создания эллипса инструментом 3 Point Ellipse (Эллипс по 3 точкам) необходимо зафиксировать указатель в начальной точке одной из осей эллипса, после чего, не отпуская клавишу мыши, растянуть указатель на длину оси и отпустить кнопку. Таким образом, на первом этапе определяется одна из осей эллипса. После этого необходимо показать длину другой полуоси эллипса. Для этого указатель следует переместить в сторону от созданной оси и щелкнуть указателем.
7.	Создайте произвольные эллипс, сегмент и дугу. Для задания параметров
сектора и дуги воспользуйтесь строкой атрибутов Property Bar (Свойства).
Задание № 2.5. Работа инструментом Smart Drawing (Интеллектуальное рисование)
Инструмент Smart Drawing (Интеллектуальное \ Умное рисование) предназначен для рисования вручную (как обычным карандашом, или пером), простых фигур, таких как прямоугольник, параллелограмм, трапеция, круг или эллипс. После приближенного создания программа автоматически «исправ-

ляет» их, распознавая выполненную фигуру. Инструмент позволяет исправить криволинейные сегменты, приближенные к прямым линиям, на линейные сегменты.
При выборе инструмента на панели Property Bar (Свойства) отображаются следующие параметры:
Shape Recognition Level (Уровень распознавания фигур). Параметр принимает значения от None (Нет), при котором процесс распознавания фигур отключен, до Highest (Наивысший), при котором нарисованная фигура анализируется более тщательно. Например, при уровне Lowest (Низший) фигура, приближенно напоминающая трапецию, скорее всего будет преобразована в прямоугольник, а при уровне Highest (Наивысший) — в трапецию.
Smart Smoothing Level (Уровень сглаживания) имеет аналогичные, как и параметр Shape Recognition Level (Уровень распознавания фигур) дискретные значения и позволяет задать вариант сглаживания контура фигуры перед ее распознаванием.
1. Выберите инструмент Smart Drawing (Интеллектуальное \ Умное рисование).
2. На панели Property Bar (Свойства) установите значение параметра Shape Recognition Level (Уровень распознавания фигур) Medium (Среднее), а значение параметра Smart Smoothing Level (Уровень сглаживания) Low (Низкое).
3. Нарисуйте приближенный круг. В зависимости от вашей точности рисования, через несколько секунд, скорее всего, он будет распознан и перерисован в правильный круг. Для проверки выделите его инструментом Pick (Стрелка) и прочитайте, что написано в строке состояния.
4. Нарисуйте звезду как замкнутый контур. Если вы сделали это достаточно точно, она будет распознана как криволинейный контур и ее можно будет закрасить внутри. После создания объектов похожих на автофигуры у них отображается красный маркер для изменения их размера.
5. Нарисуйте параллелограмм. После распознавания в его правом верхнем углу отобразится красный маркер. Выберите инструмент Shape (Форма) и измените форму полученной фигуры.
В процессе рисования инструментом Smart Drawing (Интеллектуальное рисование) создаваемый контур можно исправить. Для этого необходимо нажать клавишу Shift и рисовать вдоль контура в обратном направлении, «стирая» ранее созданную линию. После этого, отпустив клавишу Shift, рисование можно продолжить.
Задание № 2.6. Работа инструментом Artistic Media (Художественное оформление \ Имитация)
Инструмент Artistic Media (Художественное оформление \ Имитация) имеет пять режимов, которые представлены в виде кнопок-пиктограмм в левой части полосы атрибутов:

Первая левая кнопка — режим Preset (Заготовка). В этом режиме можно создавать объекты, толщина которых меняется в соответствии с формой готовых образцов. Образцы предлагаются в раскрывающемся меню Preset Stroke List (Список заготовок штрихов) на полосе атрибутов. Левее списком с образцами находится поле Artistic Media Tool Width (Ширина инструмента), в котором задается максимальная ширина штриха (диапазон от 0,764 до 254 мм). Еще левее - поле степени сглаживания Freehand Smoothing (Сглаживание кривой). Диапазон значений от 0 до 100.
1. Включите инструмент Artistic Media (Художественное оформление \ Имитация).
2. Выберите режим Preset (Заготовка).
3. В раскрывающемся меню Preset Stroke List (Список заготовок штрихов) выберите любой образец.
4. Нажмите левую клавишу мыши и нарисуйте произвольную кривую.
5. Измените заливку объекта.
6. Командой Arrange ► Break Apart (Упорядочить ► Разъединить) разъедините получившийся составной объект.
7. Выберите инструмент Pick (Стрелка) и изучите получившиеся кривые (одна замкнутая, другая не замкнутая).
Вторая кнопка-пиктограмма на полосе атрибутов — режим Brush (Кисть). Позволяет создавать мазки в виде сложных форм или текста. Параметры режима: Freehand Smoothing (Сглаживание кривой), Tool Width (Толщина), Brush Stroke List (Форма кисти); кнопка Save (позволяет сохранить объект в качестве формы кисти), кнопка Delete (позволяет удалить любой из вариантов, имеющихся в списке).
Можно создать форму кисти в виде строки текста:
1. Напишите строку текста. Для этого щелкните на кнопке инструмента Text (Текст), щелкните мышью на свободном месте рабочего поля, введите несколько текстовых символов;
2. Включите инструмент Artistic Media (Художественное оформление \ Имитация);
3. Выберите режим Brush (Кисть);
4. Появившемся маркером (в форме кисти) щелкните на написанном тексте;
5. Щелкните на кнопке Save (Сохранить);
6. В открывшемся диалоговом окне Save (Сохранить) введите имя нового файла и сохраните.
7. Нажмите левую клавишу мыши и нарисуйте произвольную кривую.
8. 
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Третья кнопка — режим Sprayer (Распылитель).
ВАЖНО! В списке Spraylist File List (Набор файлов распыляемых объектов) есть образцы, применение которых может привести к не корректному результату.
Имеется возможность создания своего распыляемого объекта.
1. Нарисуйте простой геометрический объект, например, звезду инструментом Complex Star (Составная звезда).
2. Активизируйте инструмент Artistic Media (Художественное оформление \ Имитация), включите режим Sprayer (Распылитель). В списке Spraylist File List (Набор файлов распыляемых объектов) выберите вариант New Spraylist.
3. Выделите указателем (в форме кисти) созданный вами объект. Щелкните на пиктограмме Add to Spraylist (Добавить в список объектов).
4. Проведите «кистью» произвольную траекторию в рабочем поле листа.
5. Попробуйте поменять размер объектов распыления в поле Size (Размер).
6. С помощью полей Dabs/Spacing (Мазки/Интервалы) измените интервалы между объектами.
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Четвертая кнопка на панели атрибутов Artistic Media — режим Calligraphic (Каллиграфия). В случае активизации этой кнопки включается инструмент, имитирующий плакатное перо. На панели атрибутов появляются новые параметры: Freehand Smoothing (Сглаживание кривой), Width (Ширина инструмента) - определяет максимальный размер штриха в диапазоне от 0,762 до 254 мм; Angle (Угол) - определяет угол наклона “пера”.
Режим Calligraphic (Каллиграфия) нельзя путать с полем Calligraphy (Каллиграфия) диалогового окна Outline Pen (Перо для контура).

1. Сначала создайте объект инструментом Artistic Media (Художественное оформление \ Имитация) в режиме Calligraphic.
2. Затем создайте толстую линию инструментом Freehand (Свободная форма \ Рисование). Примените к ней средства предоставляемые полем Calligraphy (Каллиграфия) диалогового окна Outline Pen (Перо для контура \ абриса).
3. Сравните полученные результаты.
Пятая кнопка панели атрибутов инструмента Artistic Media (Художественное оформление \ Имитация) включает режим Pressure (Нажим), который реализуется при использовании специальных устройств, например, графических планшетов.
ВАЖНО! Объекты, созданные инструментом Artistic Media (Художественное оформление \ Имитация), желательно преобразовать командой Arrange ► Break Apart (Упорядочить ► Разъединить).
Самостоятельная работа по теме 2
1. Выберите два любых изображения из ниже представленных.
2. Используя инструменты для построения стандартных объектов, для создания произвольных контуров и для редактирования формы, создайте эти два изображения. Постарайтесь сделать это наиболее похоже на образцы.
3. Желательно, чтобы даже белые объекты были замкнутыми и имели заливку.
Л
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4. Сохраните документ для демонстрации преподавателю.

[bookmark: bookmark1]Практическая работа по теме 3. Создание и обработка текстов. Редактирование и форматирование текстов
Задание № 3.1. Создание бейджа.
1. Создайте новый документ с размерами 90x55 мм (альбомная ориентация). Для этого выполните команду File ► New (Файл ► Создать \ Новый документ). Или в диалоговом окне Create a New Document (Создание документа), или на панели атрибутов Property Bar (Свойства) введите в цифровое поле ширина страницы 90, а в поле высота — 55 (единицы измерения миллиметры). Тогда формат станет Custom (Заказной), а ориентация — альбомная.
2. Включите инструмент Text (Текст).
Откройте список шрифтов на панели атрибутов и выберите шрифт Arial (или другой, в котором есть кириллица).
3. После щелчка на названии шрифта появится окно Text Attributes (Параметры текста), в котором предлагается согласиться с новыми параметрами текста по умолчанию. Поставьте оба флажка и щелкните на кнопке OK.
4. Щелкните на странице и наберите строчными буквами как один текстовый блок Artistic Text в три строки/абзаца текст, представленный на рис. 3.1. На параметры текста пока не обращайте внимания.
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5. Установите выключку по центру (Center).
6. Инструментом Text (Текст) выделите две верхние строчки.
7. С помощью окна Text ► Change Case (Текст ► Изменить регистр) назначьте ВСЕ ПРОПИСНЫЕ.
8. На панели атрибутов панели атрибутов Property Bar (Свойства) установите для них кегль — 44 пт, начертание — жирный (Bold).

9. Третья строка — все строчные, кегль — 27 пт, начертание — курсив (Italic).
10. Расположите текстовый блок по центру этого маленького документа.
11. 
11. Поэкспериментируйте с другими шрифтами, установленными на компьютере.

Задание № 3.3. Создание визитной карточки
1. Начните новый документ формата А4 книжной ориентации.
2. Создайте прямоугольник размерами 90×50 мм (Он нужен только для указания габаритов и будет удален.)
3. Включите инструмент Text (Текст).
4. Шрифтом Arial (или другим, в котором есть кириллица) кеглем 8 наберите строчными буквами как один текстовый блок Artistic Text текст, представленный на рис. 3.4.
5. Назначьте выключку по центру (Center). На остальные параметры текста пока не обращайте внимания.
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6.	Вырежьте в буфер обмена командой Cut (Вырезать) слова «Санкт-
Петербургская академия методов и техники управления». Поместите их ко
мандой Paste (Вставить) как отдельный текстовый блок Artistic Text. На
значьте этому тексту параметр — ВСЕ ПРОПИСНЫЕ, и поделите на два аб
заца. Установите кегль 9. Разместите вверху прямоугольника.
7. Вырежьте слова «Кафедра компьютерного проектирования и дизайна» и поместите их как отдельный текстовый блок Artistic Text. Назначьте этому тексту стиль начертания — жирный (Bold).
8. Аналогичным образом создайте отдельный текстовый блок Artistic Text в два абзаца со словами «Иванов Иван Иванович». Назначьте тексту кегль 12, жирный (Bold).
9. Слову «преподаватель» в отдельном текстовом блоке Artistic Text назначьте кегль 9, начертание — курсив (Italic).

10. Оставшимся словам назначьте начертание — жирный (Bold) и разделите их на два блока Artistic Text, каждый по два абзаца. В одном блоке — адрес и телефон, в другом — электронный адрес и адрес сайта.
11. Расположите все созданные и отформатированные тексты по образцу.
12. 
12. Две горизонтальные линии, видимые на рис. 3.4., представляют собой прямоугольники с черной заливкой (Black), без контура, с габаритными размерами 85×0,5 мм.
12. Теперь карточки можно напечатать на принтере. С помощью вспомогательных линий поделите лист документа на 10 областей размером 90×50 мм. В качестве ориентира можно использовать большой прямоугольник габаритных размеров визитки.
13. Разместите в эти области дубликаты визиток. Так как обычно у визиток не бывает рамок, удалите все большие прямоугольники. Чтобы знать, по каким линиям разрезать бумагу после печати, по краям листа поставьте метки — короткие отрезки под направляющими. У вас должно получиться так, как на рис. 3.5.
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Задание № 3.5. Создание круглой печати
1. Создайте три концентрические окружности без заливки с диаметрами: 60; 45 и 35 мм. Окружности должны быть обязательно концентрические, то есть их центры должны совпадать. (Здесь окружность это эллипс, у которого ширина равна высоте.)
2. Толщины контура самой большой и самой маленькой окружностей задайте 1 пт (0,353 мм), толщина контура средней окружности - 0,5 пт (0,176 мм).
3. Наберите три отдельных текстовых блока Artistic Text шрифтом Arial, кеглем 12 пт, соблюдая регистр:
ДИЗАЙНЕР КОМПЬЮТЕРНОЙ ГРАФИКИ
ИВАН ИВАНОВИЧ ИВАНОВ
Выпускник ЛИМТУ
4. Перед словом ИВАН и после слова ИВАНОВ поставьте булет (жирная точка посреди строки), не отделяя его пробелом от слов. Булет может быть введен или с помощью цифровой клавиатуры (Alt+0149), или с помощью Таблицы символов операционной системы Windows.
5. Инструментом Pick (Стрелка) выделите одну окружность, наружную, и один текстовый блок «ДИЗАЙНЕР КОМПЬЮТЕРНОЙ ГРАФИКИ». Выполните команду Text ► Fit Text To Path (Текст ► Текст вдоль пути \ Разместить текст вдоль траектории).
6. В списке Tick Snapping (Привязка к делениям \ Метка прилипания) поставьте Tick snapping off (Отключить…).
7. Ухватившись за любую букву, поверните текст на 180°, чтобы центр текста оказался внизу.
8. С помощью маленьких кнопок поля смещения базовой линии текста на панели атрибутов переместите текст к центру (или от центра) окружностей. Текст должен оказаться в кольце между наружной и средней окружностями. Следите за тем, чтобы нижние элементы буквы «Д» не «прилипли» к средней окружности. Параметр будет иметь отрицательное значение (может оказаться -6 мм).
9. С помощью списка / поля кеглей на панели атрибутов подберите кегль текста, чтобы верхний элемент буквы «Й» почти касался, но не «прилипал» к наружной окружности (возможно 16,5 пт).
10.	С помощью инструмента Shape (Форма) подберите такие расстояния ме
жду буквами и словами, чтобы текст заполнил почти всю длину кольца. Ори
ентируйтесь на рис. 3.7.
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11. Текст «ИВАН ИВАНОВИЧ ИВАНОВ» разместите по другой окружности.
12. По оставшейся свободной третьей окружности разместите текст «Выпускник ЛИМТУ». Для него нужно использовать кнопки отзеркаливания.
13. Остальные параметры: значение смещения базовой линии текста от контура; кегль; межбуквенные и межсловные расстояния подберите самостоятельно.
14. В печати применены три символа шрифта Wingdings. Они вставлены в документ из пристыкованного окна Insert Character (Вставить литеру \ символ) как кривые с помощью инструмента Pick (Стрелка).
15. Если после создания печати изменить ее размер, то иногда происходит сбой масштабирования текста. На рис. 3.8. представлен пример уменьшения выполненной печати.
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ВАЖНО! При создании таких специфических объектов как Text on a Path (Текст на траектории) необходимо сразу выполнять их в заданном размере.

Задание № 4.2. Присваивание параметров одного объекта другому ВАЖНО! Параметры любого объекта можно присвоить другому объекту.
1. Выберите объект, параметры которого нужно изменить. В меню Edit (Правка) выберите команду Copy Properties From... (Копировать свойства...).
2. В диалоговом окне выберите нужные опции Outline Pen (Параметры обводки), Outline Color (Цвет обводки), Fill (Заливка), Text Properties (Параметры текста). Щелкните мышью на кнопке OK.
3. Большой черной стрелкой укажите объект, параметры которого нужно скопировать. Исходный объект поменяет внешний вид.
4.	Аналогичные действия можно выполнять инструментами Eyedropper
(Пипетка) и Paintbucket (Лейка \ Заполнитель). Они позволяют переносить
параметры одного объекта на другой. Выбор копируемых параметров осуще
ствляется на панели атрибутов Property Bar (Свойства). Для перехода между
инструментами нажмите и удерживайте клавишу <Shift>.
Освойте эти приемы работы самостоятельно.
Задание № 4.3. Работа инструментом Smart Fill (Интеллектуальная заливка)
Инструмент Smart Fill (Интеллектуальная \ Умная заливка) позволяет применять заливки для любой замкнутой области. В отличие от других инструментов заливки, с помощью которых выполняется заливка только объектов, инструмент Smart Fill (Интеллектуальная \ Умная заливка) определяет края области и создает замкнутый контур, поэтому можно выполнить заливку области. Если пути одного или нескольких объектов образуют замкнутую об-

ласть, для нее можно применить заливку. Инструмент Smart Fill (Интеллектуальная \ Умная заливка), по существу, создает новый объект, для которого можно применить заливку. Этот объект можно переместить, скопировать или отредактировать.
1. С помощью инструмента Freehand (Свободная линия \ Рисование) создайте не замкнутую кривую, которая сама себя пересекает.
2. Выберите инструмент Smart Fill (Интеллектуальная \ Умная заливка).
3. На панели атрибутов Property Bar (Свойства) оставьте параметры заливки по умолчанию.
4. Щелкните внутри замкнутой области, для которой требуется заливка.
На основе замкнутой области будет создан новый объект, для которого будут использованы текущая заливка и стили абриса. Новый объект появится в слое поверх существующих объектов.
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5. Самостоятельно изучите параметры на панели атрибутов Property Bar (Свойства) при выбранном инструменте Smart Fill (Интеллектуальная \ Умная заливка).
Самостоятельная работа по теме 4
1. Создайте новый документ.
2. Создайте объекты по представленным образцам рис. 4.3. Присвойте им соответствующие градиентные заливки (пусть не совсем точно). Подсказка — трубопровод состоит из 10 объектов, причем, десятый последний объект — черный контур без заливки поверх остальных объектов.
3. Добейтесь более точного соответствия образцу при редактировании инструментом Interactive Fill (Интерактивная заливка).
4. 
Активизируйте инструмент Interactive Fill. На панели атрибутов появятся элементы управления свойствами заливки. Первая кнопка (Edit Fill) откроет окно, с помощью которого можно менять заливку, но в интерактивном режиме удобнее работать, не открывая диалоговых окон. На экране появляются новые маркеры в виде квадратиков. Их перемещение позволяет менять внешний вид заливки. Их можно добавлять. Для изменения или добавления нового цвета выделите нужный маркер и щелкните на образце нужного цвета на цветовой панели.
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5. Сохраните документ для демонстрации преподавателю.

[bookmark: bookmark2]Задание № 5.1. Изображение в перспективе
1. Создайте новый документ с типичными настройками.
2. Создайте и выделите объект или группу объектов.
3. Выберите команду Add Perspective (Добавить перспективу) в меню Effects (Эффекты).

4. Переместите мышью один из четырех появившихся угловых маркеров. При удерживании клавиши <Ctrl> маркер можно перемещать только горизонтально или вертикально. Одновременное удерживание клавиш <Ctrl>+<Shift> позволяет передвигать сразу два маркера. Появившийся при перемещении маркеров крестик является точкой пересечения граничных линий - точкой схода.
5. Для удаления перспективы выберите команду Clear Perspective (Отменить перспективу) из меню Effects (Эффекты).
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Задание № 5.2. Оболочка объекта и ее модификация
1. Выделите объект или группу объектов.
2. Выберите команду Envelope (Оболочка) в меню Effects (Эффекты). Появится пристыкованное окно Envelope.
3. Щелкните по кнопке Add New (Добавить новую).
Вокруг выделенного объекта появятся узлы, перемещая которые можно изменить имеющийся контур. Программа автоматически переключится на инструмент Interactive Envelope (Интерактивная настройка огибающей) в группе инструментов Interactive Tool.
Кнопка Add Preset (Добавить готовую оболочку) выводит список образцов, которые можно использовать как оболочки, вместо кнопки Add New (Добавить новую).

Четыре кнопки, позволяющие задавать режим редактирования оболочки: по прямой; по дуге; по двойной дуге и основной — свободный режим редактирования формы оболочки.
В списке представлены четыре способа деформации объекта в результате применения эффекта Envelope: Horizontal (Горизонтальный); Original (Оригинальный \ Исходный); Putty (Пластичный \ Угловой); Vertical (Вертикальный).
Флажок Keep lines (Сохранить прямые) включает режим, в котором прямые линии исходного объекта не искажаются.
С помощью кнопки Create From (Создать из \ Пипетка) можно создать оболочку по форме существующего объекта.
4. Отмена преобразований выполняется командой Clear Envelope (Отменить оболочку) из меню Effects или кнопкой на панели атрибутов.
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ВАЖНО! Редактировать эффекты Add Perspective (Добавить перспективу) и Envelope (Оболочка) удобно инструментом Shape (Форма).
Задание № 5.3. Эквидистантные линии – эффект контур
1. Создайте и/или выделите объект.
2. Выберите команду Contour (Контур \ Ореол) в меню Effects (Эффекты). Появится пристыкованное окно Contour с тремя вкладками или областями.
В первой вкладке \ области переключатель — куда прорисовывать контуры: To centre (К центру), Inside (Внутрь ) или Outside (Наружу).
Расстояние между контурами установите в поле Offset. Количество контуров — в поле Steps.

Во второй вкладке \ области устанавливается характер цветового перехода, цвет конечной контурной линии и цвет заливки последнего объекта в группе контура.
В третьей вкладке \ области окна есть движки изменения параметров промежуточных контуров и их цвета.
Исходный управляющий объект можно выделить отдельно и редактировать, в том числе и форму инструментом Shape (Форма).
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ВАЖНО! Можно разбить группу контура на отдельные объекты. Для этого выделите группу и выберите в меню Arrange (Упорядочить \ Монтаж) команду Break Apart (Разделить). Затем разгруппируйте изображение командой Ungroup (Разгруппировать).
Задание № 5.4. Перетекание \ Пошаговый переход одного объекта в другой
1.	Выберите команду Blend (Перетекание \ Пошаговый переход) в меню Ef
fects (Эффекты).
Появится пристыкованное окно Blend с четырьмя вкладками.
2. Выберите два векторных объекта (или группы).
3. В цифровом поле первой вкладки установите количество шагов.
4. Нажмите Apply (Применить).
5. Посмотрите, как меняется изображение перехода при изменении параметров в поле угла поворота Rotate и при включенном режиме Loop (Петля).
Во второй вкладке \ области окна есть движки изменения параметров промежуточных фигур и их цвета при перетекании.
В третьей вкладке \ области можно регулировать цвета промежуточных объектов.
В четвертой вкладке \ области — дополнительные возможности преобразования перехода.

Исходные управляющие объекты можно выделять по отдельности и редактировать, в том числе и форму инструментом Shape (Форма).
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ВАЖНО! Можно разбить группу перетекания на отдельные объекты. Для этого выделите группу и выберите в меню Arrange (Упорядочить \ Монтаж) команду Break Apart (Разделить). Затем разгруппируйте изображение командой Ungroup (Разгруппировать).
Задание № 5.5. Перетекание \ Пошаговый переход по направляющей
1. Создайте перетекание \ пошаговый переход между двумя объектами.
2. Нарисуйте траекторию, вдоль которой вы хотели бы сделать перетекание.
3. Для осуществления перехода вдоль заданной кривой выделите группу перетекания и щелкните кнопку Path в окне Blend или на панели атрибутов. Откроется контекстное меню управления траекторией.
4. Выберите команду New Path (Создать траекторию) и укажите появившейся стрелкой линию, вдоль которой пойдет перетекание. При этом в первой вкладке окна появятся два новых флажка: Blend along full path (Перетекание по всей траектории) и Rotate all objects (Повернуть все объекты).
После создания перехода вдоль траектории можно отредактировать узлы траектории инструментом Shape. Траекторию можно сделать невидимой, отключив цвет контура.
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Задание № 5.6. Перетекание \ Пошаговый переход по тексту как по направляющей
1. Наберите небольшой текст как Artistic Text.
2. Создайте два маленьких ярких объекта, например, две звездочки.
3. Создайте Blend (Перетекание \ Пошаговый переход) между двумя объектами с большим (400-600) числом шагов.
4. Для осуществления перехода вдоль контура текста при выделенной группе перетекания и щелкните кнопку Path в окне Blend или на панели атрибутов. Откроется контекстное меню управления траекторией.
5. Выберите команду New Path (Создать траекторию) и укажите появившейся стрелкой текст, вдоль которой пойдет перетекание.
6. Поставьте флажок Blend along full path (Перетекание по всей траектории).
7. Буквы текста выделите, и сделайте прозрачными.
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Задание № 5.7. Проекция трехмерного объекта на плоскость
1. Создайте и/или выделите объект.
2. Выберите команду Extrude (Выдавливание \ Экструдирование) в меню Effects (Эффекты).
Появится пристыкованное окно Extrude с пятью вкладками. Внизу окна, кроме кнопки Apply (Применить), присутствует кнопка Edit (Изменить \ Редактировать). Всегда доступна только одна из них — жмите на ту, что доступна.
В первой вкладке — схема способа экструдирования.

Список способов экструдирования. Перспективные: Small Back (Уменьшение в глубину); Small Front (Уменьшение вперед); Big Back (Увеличение в глубину); Big Front (Увеличение вперед). Параллельные: Back Parallel (Параллельно в глубину); Front Parallel (Параллельно вперед).
3.	Для начала выберите Small Back (Уменьшение в глубину).
Список типов привязки точки схода: VP Locked To Object (Точка схода привязана к объекту), VP Locked To Page (Точка схода привязана к страние), Copy VP From (Копировать точку схода с...), Shared Vanishing Point (Общая точка схода нескольких объектов).
4.	Выберите VP Locked To Object (Точка схода привязана к объекту).
Depth — глубина перспективного экструдирования в процентах от расстояния между объектом и точкой схода.
5.	Поставьте в этом поле число 20.
Координаты точки схода в цифровых полях не меняйте. Точка схода отображается в документе как косой крестик. Ее можно перемещать интерактивно.
6.	Подвиньте точку схода выше и правее объекта.
Вторая вкладка — вкладка вращения, только для перспективного экструди-рования. Содержит поле интерактивного вращения и две кнопки: возврата в нулевое состояние и вызова цифровых установок.
Третья вкладка — вкладка освещения. На ней отображаются кнопки включения и поле размещения лампочек. Вы можете установить три источника освещения.
7.	Щелкните по кнопке с лампочкой 1. Появившийся на решетке кружок с
цифрой можно переместить мышью в любой узел решетки. Посмотрите, как
изменяются блик и тень сферы в окне просмотра. Лампочки 2 и 3 дают до
полнительное освещение. Интенсивность освещения выделенной лампочки
регулируется движком Intensity (Интенсивность). Флажок Use full color
range (Полноцветный набор цветов) обеспечивает более точное соотношение
освещенных и затененных граней.
В четвертой вкладке цветных заливок есть переключатель: Use Object Fill (Использовать заливку объекта), Solid Color (Сплошная заливка), Shade (Тень \ Растяжка цветов). И соответствующие списки цветов.
Вкладка Bevel (Фаска) позволяет создать стесанные края исходного объекта (фаску). Параметры фаски устанавливаются в полях Bevel depth (Глубина скоса) и Bevel angle (Угол скоса). При этом должен быть установлен флажок Use Bevel (Применить фаску). Если установить флажок Show Bevel Only (Показать только фаску), вид объекта изменится: останутся только стесанные кромки.
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ВАЖНО! Можно разбить группу экструдирования на отдельные объекты. Для этого выделите группу и выберите в меню Arrange (Упорядочить \ Монтаж) команду Break Apart (Разделить). Затем разгруппируйте изображение командой Ungroup (Разгруппировать).
Задание № 5.8. Линзы
1. Над каким-либо изображением создайте объект, имеющий замкнутый контур и не входящий в группу, например, эллипс. Его можно назначить линзой, сквозь которую можно “смотреть” на нижележащие объекты.
2. Из меню Effects (Эффекты) вызовите команду Lens (Линза). В появившемся пристыкованном окне Lens можно выбрать одиннадцать типов линз.
3. Выделите эллипс и раскройте список выбора линзы. Посмотрите, как они работают.
4. Изучите действие каждой из 11 линз.
5. Изучите действие флажков:

· Frozen (Заморозить) — «приклеивает” изображение к линзе;
· Viewpoint (Точка взгляда) — перемещает изображение, видимое сквозь линзу. При этом линза и объект остаются неподвижны. Включите в пристыкованном окне режим Edit и переместите точку обзора;
· Remove Face (Удалить фон) — применяет эффект только к объекту, но не к фону (если он установлен).
[image: ]

Кроме того. Моделирование прозрачности можно реализовать в интерактивном режиме с помощью кнопки инструмента Interactive Transparency (Интерактивная прозрачность). Инструмент может использовать все виды заливок, менять прозрачность. Вид панели атрибутов меняется в зависимости от того, какой тип заливки выбран (Uniform, Fountain, Pattern, Texture). Основное диалоговое окно выводится кнопкой Edit (крайней левой кнопкой панели атрибутов). Режимы взаимодействия “прозрачной линзы” и исходного объекта даны в списке Transparency Operation (Режим \ Децствие прозрачности).
ВАЖНО! Изображения с использованием линз и интерактивной прозрачности корректно распечатываются только после преобразования в пиксельное (растровое) изображение.
Задание № 5.9. Фигурная обрезка
Для создания эффекта PowerClip (Фигурная обрезка) необходимо наличие двух объектов: того, который будет маскироваться (содержимое) и требуемой формы, контейнера в который будет помещен исходный объект.
1. Выделите объект или группу объектов, которые необходимо поместить в контейнер.
2. Из меню Effect (Эффекты) выберите в подменю PowerClip команду Place Inside Container (Поместить в контейнер). Появится большая черная стрелка.
3. Щелкните стрелкой на объекте-контейнере.
Функция PowerClip скрывает те части исходного объекта, которые выходят за пределы формы.
В качестве формы можно использовать несколько объектов, предварительно их сгруппировав. После преобразования полученные изображения можно разгруппировать. Каждая часть полученного изображения не зависима от других частей.
4. Для редактирования обрезки объекта выберите в подменю PowerClip режим Edit Contents (редактировать содержимое). На экране появится исходный объект, доступный для изменений.
5. После окончания редактирования выберите в подменю PowerClip режим Finish Editing This Level (Завершить редактирование).
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Задание № 5.10. Мягкий край
1. Создайте круг.
2. Из меню Effects (Эффекты) вызовите команду Bevel (Скос \ Фаска).
3. В появившемся пристыкованном окне Bevel в верхнем списке выберите Soft edge (Мягкий край).
4.	Нажмите Apply. Рассмотрите результат, поменяйте параметр Distance
(Размер скоса). Снова нажмите Apply. Поменяйте другие параметры. Создай
те несколько изображений кнопок для сайта, различных, но в одном стиле.
[image: ]
ВАЖНО! Если применить к объекту Bevel (Скос) команду Break Apart (Разделить) из меню Arrange (Упорядочить \ Монтаж), то можно убедиться, что изображение Soft edge пиксельное (растровое).
Использование в окне Bevel в верхнем списке опции Emboss (Рильеф), приводит всего лишь к созданию двух дополнительных объектов.
Задание № 5.11. Интерактивная деформация
1. Активизируйте инструмент Interactive Distortion (Интерактивная деформация), расположенный на панели инструментов в группе интерактивных инструментов. Три левые кнопки на панели атрибутов задают типы деформации: Push and Pull (Тяни-Толкай), Zipper (Зигзаг), Twister (Скручивание). Результат этих преобразований почти всегда случаен, так как зависит от многих факторов, но получаемые фигуры могут быть очень интересными.
2. Попробуйте применить этот инструмент к простым фигурам.
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Задание № 5.12. Интерактивная тень
1. Выберите инструмент Interactive Drop Shadow (Интерактивная тень), рас-положеный в группе интерактивных инструментов на инструментальной панели. 2. Указателем мыши потяните какой либо замкнутый объект.
Панель атрибутов позволяет менять: светлоту тени; степень размытия; цвет и пр. Тип тени по направлению: Inside (Внутрь), Middle (По центру), Outside (Наружу), Average (Усредненная). Режимы взаимодействия «полупрозрачной тени» и нижележащих объектов даны в списке Transparency Operation (Режим прозрачности).
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Этот эффект можно применять к растровым объектам.
3. Создайте несколько примеров.
ВАЖНО! Изображения с использованием интерактивной тени, по сути, используют линзу и корректно распечатываются только после преобразования в пиксельное (растровое) изображение.
Самостоятельная работа по темам 1-5
1. Повторите несколько приемов работы с текстом, объектами и эффектами.
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